Spotlight–8 Image Analysis Software

Robert Klimek and Ted Wright
Glenn Research Center, Cleveland, Ohio
Since its founding, NASA has been dedicated to the advancement of aeronautics and space science. The NASA Scientific and Technical Information (STI) Program Office plays a key part in helping NASA maintain this important role.

The NASA STI Program Office is operated by Langley Research Center, the Lead Center for NASA's scientific and technical information. The NASA STI Program Office provides access to the NASA STI Database, the largest collection of aeronautical and space science STI in the world. The Program Office is also NASA's institutional mechanism for disseminating the results of its research and development activities. These results are published by NASA in the NASA STI Report Series, which includes the following report types:

- **TECHNICAL PUBLICATION.** Reports of completed research or a major significant phase of research that present the results of NASA programs and include extensive data or theoretical analysis. Includes compilations of significant scientific and technical data and information deemed to be of continuing reference value. NASA's counterpart of peer-reviewed formal professional papers but has less stringent limitations on manuscript length and extent of graphic presentations.

- **TECHNICAL MEMORANDUM.** Scientific and technical findings that are preliminary or of specialized interest, e.g., quick release reports, working papers, and bibliographies that contain minimal annotation. Does not contain extensive analysis.

- **CONTRACTOR REPORT.** Scientific and technical findings by NASA-sponsored contractors and grantees.

- **CONFERENCE PUBLICATION.** Collected papers from scientific and technical conferences, symposia, seminars, or other meetings sponsored or cosponsored by NASA.

- **SPECIAL PUBLICATION.** Scientific, technical, or historical information from NASA programs, projects, and missions, often concerned with subjects having substantial public interest.

- **TECHNICAL TRANSLATION.** English-language translations of foreign scientific and technical material pertinent to NASA's mission.

Specialized services that complement the STI Program Office's diverse offerings include creating custom thesauri, building customized databases, organizing and publishing research results . . . even providing videos.

For more information about the NASA STI Program Office, see the following:


- E-mail your question via the Internet to help@sti.nasa.gov

- Fax your question to the NASA Access Help Desk at 301–621–0134

- Telephone the NASA Access Help Desk at 301–621–0390

- Write to:
  
  NASA Access Help Desk
  NASA Center for AeroSpace Information
  7121 Standard Drive
  Hanover, MD 21076
Spotlight–8 Image Analysis Software

Robert Klimek and Ted Wright
Glenn Research Center, Cleveland, Ohio

National Aeronautics and Space Administration

Glenn Research Center

January 2006
Acknowledgments

The images used in Examples 2 and 3 were obtained courtesy of the Droplet Combustion Experiment and image used in Example 4 was obtained courtesy of the Capillary Flow in Interior Corners Experiment, both part of the Microgravity Science Division of NASA Glenn. Abel transform theory and original source code was obtained from Dr. Zeng-guang Yuan, National Center for Space Exploration Research (NCSER), NASA Glenn.

Trade names or manufacturers’ names are used in this report for identification only. This usage does not constitute an official endorsement, either expressed or implied, by the National Aeronautics and Space Administration.

Available from

NASA Center for Aerospace Information
7121 Standard Drive
Hanover, MD 21076

Available electronically at http://gltrs.grc.nasa.gov

National Technical Information Service
5285 Port Royal Road
Springfield, VA 22100
Spotlight–8 Image Analysis Software

Robert Klimek and Ted Wright
National Aeronautics and Space Administration
Glenn Research Center
Cleveland, Ohio 44135

Summary

Spotlight is a cross-platform GUI-based software package designed to perform image analysis on sequences of images generated by combustion and fluid physics experiments run in microgravity environment. Spotlight can perform analysis on a single image in an interactive mode or perform analysis on a sequence of images in an automated fashion.

Image processing operations can be employed to enhance the image before various statistics and measurement operations are performed. An arbitrarily large number of objects can be analyzed simultaneously with independent areas of interest. Spotlight saves results in a text file that can be imported into other programs for graphing or further analysis. Spotlight can be run on Microsoft Windows, Linux, and Apple OS X platforms.

Introduction

Historically, NASA’s film-based analysis of moving objects, whether they are flame fronts, particles, droplets, or fluid interfaces, was done manually, usually by measuring features of an image projected on a wall. Later, film analysis was performed by projecting the image onto an internal viewing screen – an improvement over projection on a wall. The movement of objects was tracked manually with a cursor moved by the operator. The later models incorporated a personal computer (PC) serial interface for downloading the data. This manual analysis was tedious and suffered from many shortcomings, including

1 NASA does not endorse any brand of computer
poor accuracy and poor repeatability. Since all the measurements were performed by hand and by eye, repeatability was always questionable.

More recently, experimental data is recorded on tape (DV, Hi8, S-VHS) and digitized with a framegrabber, however much of the motion analysis was still performed manually. This was because the types of moving objects (flame fronts, fluid interfaces, etc…) that are typically studied by the researchers in the Microgravity Science Division pose difficult and unique problems rarely encountered elsewhere and thus are difficult to track in an automated fashion.

There are many challenging types of images and difficult tracking requirements that must be overcome. In some instances, the space-based or terrestrial images are very noisy or lighting conditions are poor. In other instances, the objects must be extracted from a very busy background. In still other instances, the requirement may be to record the position of the object’s outline rather than a single point measurement. In order to accommodate all of the different requirements, significant image enhancement capabilities as well as several tracking methods must be implemented.

The inspiration for the name Spotlight comes from the idea that this program enhances and tracks objects in a video image just like in a theater where a spotlight is used to highlight and track the subject of interest as the actors move across the stage. Furthermore, a spotlight modifies the appearance of the region of interest, e.g., with the addition of light. Thus, Spotlight is representative of both the processing and tracking functions of the software.

**Getting started**

For Microsoft Windows, Spotlight-8 is available in a self-extracting executable file and has been successfully tested on versions of Windows including Win98, Win2000 and XP. On Linux Spotlight-8 is available as “rpm” files. For Macintosh, Spotlight is available as a “dmg” disk image.

**Software Installation**

**Microsoft Windows installation**

Run the setup program (“SpotlightSetup-8.exe”) and follow the install wizard’s prompts.

After setup, there will be a Spotlight-8 icon on your desktop that you can double-click to start. There will also be a Spotlight-8 entry on your Windows “Start” button.

If you need to un-install Spotlight, this can be done from the “Add/Remove Programs” section of the Windows Control Panel.

**Linux installation**

Three possibilities exist for Linux.

A. yum install Spotlight (at Glenn only and must have yum configured for the GRC repository), or
B. download the necessary rpm's and then type: rpm –Uvh *.rpm, or
C. extract the tar file:
   1. install wxPython and PIL (Python Imaging Library)
   2. type: tar xvf Spotlight-8.tar.gz
   3. type: make install
Apple OS X installation

Double click the “dmg” file to mount the disk image. Drag the Spotlight-8 application to your Applications directory.

Basic concepts

Spotlight is designed to track and/or analyze “objects” digitized from video. The “objects” that Spotlight looks for are assumed to be fairly large (roughly 10 pixels or preferably more in diameter). If you want to analyze 500 2-pixel dots, you probably should not be using Spotlight and should look for a “particle tracking” program.

Spotlight analyzes an image using one or more “areas of interest”, or “AOIs”. An AOI is usually a subset of the image, but can be the entire image as well. The AOI can have a set of image processing algorithms associated with it. The image processing algorithms can be automatically applied in sequence to enhance the image. Then, optionally, a tracking algorithm can be applied to return the position of a certain object.

In this document the word “tracking” refers to two slightly different concepts. In both cases it refers to stepping through the sequence of images in an automated fashion and performing some task. First, “tracking” may refer to the process of latching on to an object and returning the object’s position in the form of x,y coordinates. Second, “tracking” may also refer to the process of stepping through an image sequence and performing some processing operation on an AOI, whether some data is returned (and saved) or not.

Users Guide

The users guide is intended to explain Spotlight concepts. For installation instructions, see the Getting Started section. For detailed explanations of all Spotlight menu items, buttons, and dialog boxes, see the Reference Guide. Examples of how to use Spotlight are located at the end of this section.

Tracking procedures are designed to be mostly the same regardless of the type of tracking that is to be performed. This means that concepts from the extended example (example 1) should apply to most tracking situations. However, the wide variety of operations that can be combined in a “process sequence” gives Spotlight the ability to do much that is not immediately obvious. It is helpful to understand the basics of how Spotlight works before trying to come up with a sequence of processing steps needed to solve your particular analysis task.

Image sources

Spotlight is designed to track objects from a series of images. Currently, these images can be from a numbered sequence of image files saved on the hard disk. AVI and Quicktime (on Mac) files can also be read, but not saved.

The first image in a sequence of disk files is loaded using the “File→Open” command on the menu bar (or the equivalent button on the button bar, see figure 1).

Spotlight can read images in any of the following formats: tif, gif, tga, jpg, png, and bmp. It can save images with the following formats: tif, jpg, png, and bmp. Several of these formats (especially tif) support optional features or subtypes that might not be supported by Spotlight. Spotlight will automatically try to recognize files in different formats, and will generate an error message if it fails to understand the file.

For Spotlight to load a sequence of disk files, the files must be named with a convention that Spotlight can
understand. The naming convention is of the form “basenameNNN.TTT”, where NNN is an integer number, and TTT describes the file format. For example: “droplet42.tif”. Only one image per file is allowed, and the numbers in the file names must be sequential for Spotlight to treat the files as a sequence. The first part of the file name (“basename”) can be anything.

**Viewing images**

Once an image is loaded it is displayed in the main part of the Spotlight window. At the bottom right of the Spotlight window is a status display that always shows the position of the cursor within the image, and the color and intensity components of the pixel under the cursor.

Position is measured in terms of pixels, with the upper left-hand corner of the image being the origin. The first (or X) component of position is zero on the left of the image, and increases to the right. The second (or Y) component of position is zero at the top of the image, and increases in the down direction.

For color images, the status display consists of the red, green and blue channels (planes) of the color. For grayscale images, the status display consists of just the intensity plane.

**Transport controls**

Spotlight supports a set of VCR-like transport controls (buttons for Rewind, Pause, Fast Forward, etc.) that can be used to step through the sequence of images. These controls appear both as buttons on the button bar and on the menu under the “Transport” menu item.

**Areas of Interest (AOIs)**

Spotlight works with one or more subsets of the full image. Each of these subsets is called an “Area Of Interest” or AOI. An AOI is used to select an area of the image to which image processing operations will be applied, in which image measurements will be taken, and in which to search for objects to track. AOIs also have a Process Sequence list. The Process Sequence list is a list of image processing operations that will be executed sequentially. Each AOI carries a Process Sequence list. It is empty, unless the user inserts operations into it through the Process Sequence dialog box. The image processing operations that are inserted into the Process Sequence list are executed during a tracking process or by using the Aoi, Update menu item. For Process Sequence menu description, see the Reference Guide and refer to figure 14. When an image is loaded, a Whole Image AOI is also created. The Whole Image AOI surrounds the entire image and can not be moved or deleted.

**Types of AOIs**

The types of AOIs can be divided into two categories: tracking AOIs and non-tracking AOIs. The major difference between tracking and non-tracking AOI is that none of the non-tracking AOIs move themselves around from frame to frame to track objects. Non-tracking AOIs stay in the same location where they were placed. They are used primarily for processing a certain area of the image and obtaining image statistics from a defined area. The Tracking AOIs are designed to move themselves around, attempting to follow object identified in the images.

**Rectangle**

Rectangular AOIs are simple rectangles. They are useful for testing image processing operations on parts of an image before those operations are employed for tracking.
**Angle Tool**

The Angle Tool AOI is used to measure angles in the image. Additionally it can be used to rotate the image by a specified angle.

**Line Profile**

The Line Profile AOI is a line over the image and an associated separate window that displays a graph of intensities along the line. This is useful when you need to determine a good threshold level for a particular image.

**Histogram**

The Histogram AOI is a rectangular AOI and an associated separate window that displays a histogram graph of the distribution of pixel intensities within the rectangle.

**Abel Transform Tool**

The Abel Transform Tool AOI is similar to a horizontal line profile (along with a vertical centerline) and an associated separate window that displays a graph of line profile (pixel intensities) and its Abel transform. This is a special purpose tool useful in analysis of axisymmetric flame studies.

**Manual Tracking**

The Manual Tracking AOI is the most basic type of “tracking” AOI. Manual Tracking method performs tracking in semi-automated fashion, where the user specifies the “track point” manually by moving the mouse cursor over the image and clicking the left mouse button. Spotlight advances automatically to the next frame, but then waits for the mouse click again. If multiple Manual Tracking AOIs are selected, each AOI waits for its own mouse click.

**Threshold Tracking**

Threshold Tracking AOIs convert the image into a binary form (just black and white), and search for the farthest white pixel in a specified direction. The location of this pixel is recorded in the result file, and the AOI is moved so that it is centered on the location (this causes it to follow the edge of an object from frame to frame). This is the simplest type of a fully automated tracking.

**Center Tracking**

Center Tracking AOIs convert the image into a “binary” form (just black and white), and search for the center of an object enclosed inside the AOI. The location of this pixel is recorded in the result file, and the AOI is moved so that it is centered on the location.

**Local Maximum Tracking**

The Local Maximum Tracking AOIs search for the maximum intensity points inside the AOI. If multiple points of same intensity are found, the position is resolved by averaging the point locations.

**Snake Tracking**

The Snake Tracking AOI is a flexible line made up of cubic spline segments. They can be closed, so that the end point meets up with the starting point, or they can be open-ended. The Snake AOI can record to the results file the centroid and size of the objects being measured or the coordinates of all the points under the snake line.
Line Following

The Line Following AOI is used to save the coordinates of a line to a text file. The user is required to perform the necessary image processing operations to reduce the object (or its outline) to a line one pixel thick. The usage of this AOI is similar to Manual Tracking AOI in that the user is required to manually jump-start the line following procedure by clicking on the line. The coordinates of the line are saved to a text file as columns of numbers.

Manipulating AOIs

The “AOI” menu contains all of the commands for manipulating AOIs. In addition, many AOI parameters (such as their size and position) are changed with the mouse.

Creating and deleting AOIs

New AOIs are created with the “AOI→New→…” menu items. If the type of the new AOI being created is the same as the AOI currently selected, a copy of the currently selected AOI will be made, including any image processing operations in its Process Sequence list. For most AOIs (except snake) the AOI graphic just pops up over the image when new one is created.

Snake, a special case. To create a snake, select the menu item “AOI→New→Snake Tracking”, and then the control points (and line segments) are added by clicking the right mouse button on the image. Double click the right mouse button to make the snake a closed loop. If the snake is already closed, clicking the right mouse button deletes the current snake and starts a new snake.

A single “currently selected” AOI can be deleted with the “AOI→Delete” menu item or by pressing the Delete key on the keyboard. The “AOI→Delete All” menu item will delete all of the AOIs in an image.

Next and Previous AOIs

If there are more than one AOI in an image, most menu items will apply to only the “currently selected” one. The currently selected AOI is drawn with thicker (highlighted) lines. The “AOI→Next” and “AOI→Previous” menu items (and the two corresponding tool bar buttons that look like green boxes with arrows) will cycle through all of the AOIs in an image, selecting each one in turn. Information about the currently selected AOI will appear in the status bar at the bottom of the Spotlight window. A shortcut way to advance to the next AOI is by pressing the TAB key.

Moving and sizing AOIs

Dragging an AOI’s control points around with the mouse changes the size or shape of the AOI. A control point for a rectangular type AOI is a corner of the box. A control point for a linear type AOI is an end point of the line.

Snake, a special case. A snake can have any number of control points. Snake control points are denoted as small crosses. Dragging the mouse starting in a position away from any of the control points will move the entire AOI. Additionally, AOIs can be moved and sized using the “Aoi→Set Position” menu.

The snake control points have one other function. They can be individually pinned down to prevent them from moving. This can be done by holding down the Control key and clicking with the left mouse button on a control point. When the control point is pinned down, its designation changes from a cross to an X. Repeating this process returns the control point back to a movable control point.
AOI Options

The Tracking AOIs have a number of optional settings that control how the tracking is done. Selecting the “AOI→Options” menu items will bring up a dialog box that allows these settings to be edited. Each AOI has its own set of options, although some AOIs do not have specific options. A shortcut way to display the options dialog box is by pressing the letter “o” on the keyboard.

If a new AOI is created that is the same type as the currently selected AOI, it will be created with a copy of all the current AOIs options. The new AOI’s position will be offset slightly so that it is obvious that there is a new AOI, but it will be otherwise identical to the original AOI.

Updating AOIs

If an image processing sequence was selected (see section named “Image Processing”) then it might be desirable to test to see the result of applying the selected processing sequence of operations all at once. The image processing sequence can be applied to the current (highlighted) AOI by selecting the “AOI→Update” menu item (or using a shortcut by pressing the letter “u” on the keyboard). After the image processing operations are applied, the AOI will do whatever it normally does to update itself (for instance, a Histogram AOI will recalculate and display the histogram; a Threshold Tracking AOI will search for a track point and move the AOI to center on that pixel). In fact, “Updating” an AOI causes the AOI to do everything it will do when tracking with 3 exceptions: the frame is not advanced first, only the current AOI is processed, and no results are saved to the result file. This is useful for making sure the AOI will behave as expected once tracking starts.

Image Processing

Spotlight supports a number of image processing operations which can be used to enhance image details so that objects may be tracked more easily. Operations may be performed on an AOI interactively (by selecting them from the “Process” menu), or they may be included in an image processing sequence list to be applied to each frame while tracking (by adding processing operations to a Process Sequence dialog box).

Operations (interactive usage)

Selecting an image processing operation from the “Process” menu (for example: “Process→Threshold...”) will bring up a dialog box that lets you select the various parameters related to the image processing operation. Clicking the “OK” button in this dialog will immediately apply the selected image processing operation to the currently select AOI.

Batch Mode Processing (using a Process Sequence)

When tracking, a sequence of image processing operations may be required to be applied to each AOI. The sequence is specified for a particular AOI by selecting the “AOI→Process Sequence...” menu item. This brings up a dialog box (see figure 14) that allows a sequence of image processing operations to be defined and manipulated. The “Add” button adds a new image processing operation to the list (using the default parameters for that operation). The “Edit” button allows the parameters of the operation to be changed. The “Delete” button deletes the currently highlighted operation. The “Move Up” and “Move Down” buttons are used to change the order of the operations in the list. The “Load” and “Save” buttons are used to store and recall the entire list to a disk file (so that you don’t have to regenerate a complicated list every time you use Spotlight).
**Undo and Redo**

Finding the right combination of image processing operations for a set of images often involves a lot of experimentation. To make this easier, Spotlight supports “Undoing” and “Redoing” of interactive image processing operations. After an image processing operation is performed, the “ Undo” and “ Redo” menu items will be enabled (along with the corresponding tool bar buttons that perform the same functions).

The “ Undo” function reverts the AOI to the state it was in before the image processing operation was applied. If a series of image processing operations was performed, repeatedly pressing “ Undo” will step back through the entire series. Pressing “ Redo” will step forward in the series, re-applying the operations as they were performed before. If you are at the end of a series (i.e., you did an image processing operation, but did not un-do it), the “ Redo” function can be used to quickly repeat the operation. This is useful for repeatedly applying image processing functions such as “ smoothing”.

Some image processing operations are not re-doable. This happens when it makes no sense to redo such an operation. For example, it only makes sense to do a threshold operation once. Additional attempts to process an image with the same threshold will not change the pixel values at all. In such cases the Redo menu item and button are not enabled.

**Tracking**

Spotlight performs the following steps when tracking:

- The image sequence is advanced to the next frame (i.e., the next file is loaded)
- Each AOI is processed, in order, by:
  1. Applying the sequence of image processing operations.
  2. Finding the track point for this AOI.
  3. Moving the AOI so it centers on the object found.
- The accumulated tracking results for this frame are stored to a disk file

**Starting and stopping**

The tracking process can be performed one frame at a time by selecting the “ Track 1 Frame” menu item (or by clicking on the equivalent button on the button bar: the button with the “ T” and the straight arrow, see figure 1). This is primarily used for making sure that everything is set up properly before tracking a series of images.

However, the main purpose of Spotlight is performing tracking for an entire series of images. This is initiated by selecting the “ Track Continuously” menu item (or by clicking on the equivalent button on the button bar: the button with the “ T” and the arrow that loops back to point at the “ T”, see figure 1). The tracking process will repeat until it runs out of numbered images, until the selected last frame is reached, or until it is stopped manually (by clicking the “ Stop” button). Tracking can be stopped and restarted as many times as is necessary.

**Result files**

Spotlight stores all of its results in text format in a “ results file”. By default, this file is named “ results.txt”. You can select a different file for the results, view the results file, and empty the results file (erase anything already in it) from the dialog that appears by picking the “ Track Results File…” menu item (see figure 27). New data is always appended to whatever is already in the results file.
**Color Palette Application**

Spotlight can apply a color palette to an image to perform a pseudo-coloring operation. This is similar to (and sometimes used interchangeably) to false-color, which typically deals with coloring images taken outside of the visible color spectrum, e.g. infrared. This operation colorizes a grayscale or RGB image by applying a color palette (also known as a lookup table or LUT). There are two modes in which this operations can be used.

The first mode can be thought of as an image processing operation. As in all image processing operations, the pixels of the image are changed. This operation is like a filtering operation in which the pixels are changed to color in a specific way. The effect is that a grayscale image becomes an RGB image. If the original image was RGB then after the pseudo-coloring operation it remains an RGB image but the pixels are changed. Since this is an image processing operation, Undo and Redo work same as on other image processing operations and if another image is loaded, all pseudo-coloring is lost.

The second mode can be thought of as a “display trick” (a color overlay) in which the colorization is done only at the display and the pixel values are left untouched. When this mode is selected and a color palette file chosen, the palette is then applied to all images loaded after that point.

The mode is selected from the View, Options menu which brings up a dialog box (see figure 3). Under the “Pseudocolor” tab the checkbox labeled “Apply palette to display” causes the palette to be applied to all images.

The palette file is a text file (with an extension .dat) containing three columns of numbers which stand for RGB values. There are 256 lines, thus 256 RGB triplets.

**Examples**

See examples of using Spotlight in Appendix 1.
Reference Guide

The Reference Guide provides a detailed description of the menu interface, buttons, and dialog boxes.

**Spotlight Operation**

Spotlight displays images inside what is known as its Client Area (viewing area), which is the open area just below the button bar. Spotlight can be operated fully using the menus, but some operations are done easier and quicker using the buttons on the button bar. All of the buttons have a corresponding menu item; in fact, the buttons may be thought of as shortcuts to the menu items. The status bar is used to display various types of information that Spotlight generates. It is divided into two main panels. Panel 1, on the left side of the status bar, displays information about Spotlight’s current activity, primarily information about the currently selected AOI. Panel 2 displays the cursor position and color and intensity values at the cursor position. The Title Bar is used for indicating the image file name.

![Main Spotlight window](image)

Figure 1. Main Spotlight window.
**File**

The menu items under the File menu pertain to loading and saving images.

**Open**

Loads image from the hard disk. The image file formats supported are tif, tga, bmp, gif, jpg, png. This menu item has a corresponding button on the button bar, labeled “Open” (see figure 1).

**Save As**

Saves the entire image to a hard disk. The image file formats supported are tif, bmp, gif, jpg, png. This menu item has a corresponding button on the button bar, labeled “Save As” (see figure 1).

**Save AOI**

Saves the portion of the image enclosed by an Area of Interest to disk. If the AOI is a line, then it is the rectangle within the bounding box that is saved.

**Exit**

Exits from Spotlight.

**View**

The menu items under the View menu pertain to viewing the image and information about the image.

**Image Info**

Displays information about the image being displayed, such as the size and number of color planes.

**Undo**

The Undo menu item allows the user to “undo” any image processing operation performed under the Process menu. If multiple imaging operations were performed, then multiple execution of the Undo menu item will undo the imaging operations one by one. This function has a corresponding button on the button bar (see figure 1).

**Redo**

The Redo menu item allows the user the “redo” any operation that is re-doable. The Redo and Undo operations are opposites of one another. If an image processing operation was performed and is re-doable, the Redo operation will execute another iteration of the imaging operation. This function has a corresponding button on the button bar (see figure 1).

**Zoom In**

Zooms the image in 2x each time the menu item is selected. The pixel information in the image is not affected, only the view is. This function has a corresponding button on the button bar (see figure 1).
Zoom Out

Zooms the image out 2x each time the menu item is selected. The pixel information in the image is not affected. This function has a corresponding button on the button bar (see figure 1).

Zoom Original

The zoom factor is returned to 1.

Scale

Brings up a dialog box which allows the user to convert pixels (default scale units) to user units. The scale factor is calculated by division of user units by pixel units (2.0/100.0 in the example shown in Figure 2). Spatial coordinates will be multiplied by this scale factor. The scaled values will be displayed on the status line as well as written to the results file. The time scale can be used to convert frames to time units, such as seconds.

![Scale dialog box](image)

Figure 2. – Scale dialog box.

*User units* – physical units of measure such as inches or centimeters.

*Image units* – units of pixels measured in the image. Note that this is the Euclidean distance between two points. As the scale line is moved the image units value is automatically updated.

*Frame rate* – frames per second. Setting this value to 1.0, by either clicking Reset button or by typing it in, is equivalent to no scale and the Time Scale will be reported (in results file) in terms of frames.

*Save* – the scale factors may be saved to a file.

*Load* – loads the scale factors from a file.

*Reset* – resets the scale factors to 1.0, which is equivalent to no scale, i.e. pixel units.
Options

Allows the user to change program parameters. Selection of this menu brings up the Program Options dialog box.

General Options

![Program Options dialog box, General options](image)

Background Color – allows to change the color of the program background.

Correct image width – converts from rectangular pixels to square pixels. This option is intended for converting images from DV-based AVI or Quicktime files, which contain rectangular pixels, to images with square pixels, preserving the correct aspect ratio. The two check boxes are designed such that only one or the other can be selected at the same time, but not both. The third option is to have neither checked in which case no correction will be applied.

Convert DV (720x480) to square pixels (640x480) - if the size of an image or an AVI file frame is exactly 720x480 pixels then the image will be automatically resized to 640x480. If the image is not 720x480 then no action will be taken.

Correct to arbitrary width in pixels - this option will resize the image to any arbitrary width. The height will be same as the original image.
Pixel Display Type

Figure 3b. – Program Options dialog box, Pixel Display Type.

*Display Pixel Values As* – this option selects how the pixel values are displayed. By default, the pixel values are displayed as integers in the range of 0 to 255. However, with this option the pixel values can be displayed as floating point values between 0.0 and 1.0.

Pseudocolor

Figure 3c. – Program Options dialog box, Pseudocolor

*Palette file* – the palette file to be applied to the display. It is expected that the file consists of three columns of 8-bit integer numbers (range 0-255) to be mapped to R, G, and B color spaces.

*Apply palette to display* – this option controls whether a color palette will be applied. The image pixels are not affected as the palette is applied only to display for user viewing. See the Users Guide for a more in-depth discussion on color palette application.
**Transport**

The menu items under the Transport menu are related to stepping through sequence of image frames or being able to jump to a particular frame. Some of the menu items (including Rewind, Frame Back, Stop/Pause, Frame Forward, and Fast Forward) and the corresponding group of buttons on the button bar try to simulate the controls on a VCR. They are intended to make loading of sequentially numbered images easier and quicker.

**Goto Specific Frame**

Brings up a dialog box enabling to quickly jump to a specific frame in an AVI file or Quicktime file (disabled for non-video file sequence). Dialog box is shown below.

![Goto Specific Frame dialog box](image)

Figure 4. – Goto Specific Frame dialog box.

**Rewind**

Steps backward through a numbered image sequence at full speed.

**Frame Back**

Steps back one frame.

**Stop/Pause**

Stops Rewind or Fast Forward motion.

**Frame Forward**

Steps forward one frame.

**Fast Forward**

Steps forward through a numbered image sequence at full speed.

**Next Step Options...**

This menu item brings up the Next Step Options dialog box which allows the user to specify whether to step through frames or fields as well as set “Step size” and “Number of frames to track”.
Step between – this option specifies whether to load and display a frame or field image when stepping through a sequence of image files or an AVI (or Quicktime on Mac) file. When “frames” is selected, then one image is displayed for every video frame. When “fields” is selected, then two images are displayed for every video frame and two steps are required to advance one frame. Stepping through frames of an AVI (or Quicktime) file in the “fields” mode will alternate between odd and even field, effectively doubling the video frame rate. Bilinear averaging is used to fill in the unused lines of a field.

Step size – this option controls the step size in the numbered image sequence. Setting this value to, say 2, will cause Spotlight to look for and increment numbered files by 2 (im1.tif, im3.tif, etc.). Setting the step size to 0 allows tracking a single frame. This is useful for tracking many points on one image, such as manually outlining an interface.

Frames to track – this value determines how many frames are to be processed. By default, the value is set very high (essentially infinite) which requires user to stop the tracking process manually. It should be noted that the total number of frames traversed is actually Step Size multiplied by Frames to Track.

AOI

The menu items under the AOI (Area of Interest) menu deal with creating, managing, and deleting AOIs. An AOI is a subset (rectangular region) of the image in which operations take place. The AOIs are split into two categories: ones used for tracking and ones usually used for analysis. Tracking AOIs move with the object being tracked whereas the analysis AOIs are immobile. In addition to the user selectable AOIs, Spotlight automatically creates a Whole Image AOI when an image is loaded. This AOI surrounds the entire image and cannot be moved or deleted. When Whole Image AOI is selected the processing operations are applied to the entire image. See the Users Guide for detailed information on how to move and size AOIs.

New

Creates a new AOI of one the following types.
**Rectangle**

Creates a rectangular AOI to surround a rectangular region of image. The AOI can be used to perform image processing trial and error testing or for automated tracking.

**Line Profile**

Brings up the interactive line profile tool for visualizing pixel intensities under a line. The line can be moved and resized using the mouse. The line profile, displayed in a dialog box, is updated in real time as it is moved and resized. The line profile is useful for graphically illustrating pixel intensities of objects in an image, which can be useful in estimating where threshold levels should be set.

![Line Profile display dialog box.](image)

*Figure 6. – Line Profile display dialog box.*

**R, G, B, L, RGB, H, S buttons** – displays a profile of the pixel intensities under the line. The first four buttons stand for red, green, blue, and luminance, respectively. The next button labeled RGB, displays red, green, and blue line profiles all at the same time. The last two buttons display hue and saturation line profiles.

**Save** – saves the line profile values to a data file.

**Line Thickness** – changes the thickness of the profile line. The pixels under the thickened line are averaged perpendicular to the length of the line before being displayed.

**Histogram**

Brings up the interactive histogram tool for visualizing an area histogram of pixel intensities. The area is described by a rectangular AOI. As the rectangular AOI is moved or resized, the histogram displayed in a dialog box is updated as fast as the computer can keep up.
Figure 7. – Histogram display dialog box.

**R, G, B, L buttons** – displays an intensity histogram of the color plane labeled on the button. The first four buttons stand for red, green, blue, and luminance, respectively.

**Enable/Disable** – this button toggles enabling and disabling the statistics displays next to the button. This feature is put there strictly to speed up the updating of the histogram as the calculation and display of the image statistics slows down the calculation and updating of the histogram.

**Save** – saves the line profile values to a data file.

**Angle Tool**

Creates a tool for measuring and specifying angles. The Angle Tool is essentially a line with a cross-hair at one end and a circular endpoint at the other end. The cross-hair serves as the origin and the angle is determined relative to it. The angle is displayed in the main status bar. In addition to measuring angles, the Angle Tool can also be used to rotate the image using the Aoi Options dialog box.

**Abel Transform Tool**

Brings up the interactive Abel Transform Tool and the corresponding dialog box. This is a specific purpose tool designed to calculate Soot Volume Fraction on an axisymmetric flame. Abel transform is described in detail in Appendix 2.

**Manual Tracking**

This AOI performs tracking in semi-automated fashion, where the user specifies the “track point” manually by moving the mouse cursor over the image and clicking the left mouse button. Spotlight advances automatically to the next frame but then waits for the mouse click again. If multiple Manual Tracking AOIs
are selected, each AOI waits for its own mouse click. The xy position of where the left button is pressed is recorded to a file.

**Threshold Tracking**

This AOI tracks the edges of objects by performing an image threshold operation and then searching for the first occurrence of non-black pixels in a given direction. The first point found is called the track point. Some image processing is typically performed to reduce noise before the thresholding operation. The AOI moves with the object by automatically centering itself on the track point in each frame. See the Threshold Tracking Options under the AOI Options section below.

**Center Tracking**

This AOI tracks the center of an object within the AOI. There are two types of Center tracking methods: Center of Mass and Four Side Edge. The Center of Mass method calculates the center point based on pixel’s intensity (grayscale value) and its location. This method works best with binary (thresholded) images, but it is possible to use this method on grayscale images as well. The Four Side Edge method is a modification of the Threshold Tracking method (see above) where the track point is obtained from four directions (left, right, top, and bottom). The Four Side Edge method operates only on thresholded images. See the Center Tracking Options under the AOI Options section below.

**Local Maximum Tracking**

This AOI tracks the brightest pixels in within the AOI bounds. If there are multiple pixels at the same maximum intensity, the locations of those pixels are averaged. See the Local Maximum Tracking Options under the AOI Options section below.

**Snake Tracking**

The snake tracking method tracks an object using an “active contour line”. This is a flexible cubic spline curve that interacts with features in an image to move itself around (“slithering”, in snake parlance).

The snake algorithm works by moving the control points of the spline curve around, evaluating the "energy" at each position of the control points, and moving the curve to the spot where "energy" is lowest. The energy function determines how the snake will interact with features in the image and move. The energy function is a weighted sum of contributions from the various snake parameters (such as, how close are the image pixels under the snake curve to the desired ideal intensity). The weights determine the relative importance of the snake parameters. There are complex interactions between many of these parameters, so it is best to experiment with different values to try to find something that works well for your images.

The tracking results stored while snake tracking can be the average of all points along the snake line (for centroid-like measurements) or it can be the position and colors of the actual pixels under the line. Snakes may be closed into a loop or open-ended, and control points may also be pinned down to keep them from slithering. Also, see the Snake Tracking Options under the AOI Options section below.

**Line Following**

This AOI records the pixel coordinates of a line to the results file. The user is required to perform the necessary image processing operations to reduce the object (or its outline) to a line one pixel thick. The search algorithm looks for pixels with the intensity of 255. The background intensity must be less than 255, but not necessarily 0. The tracking procedure is semi-automated, similar to Manual Tracking, in that the user specifies the start point by clicking left mouse button anywhere on the line (or within a few pixels of the line). After the routine is jump started (by clicking on the line) the line following is initiated and as the routine follows along the length of the line, the pixels are changed to red color to indicate exactly which
pixels were used. Spotlight advances automatically to the next frame but then waits for the mouse click again. If multiple Line Following AOIs are selected, each AOI waits for its own mouse click.

**Delete**

Deletes the currently highlighted AOI.

**Delete All**

Deletes all AOIs.

**Next**

Selecting this menu item (or the corresponding button on the button bar, see figure 1), will select the next AOI in the sequence of AOIs displayed. When an AOI is selected, its graphic becomes highlighted and all other AOIs become disabled. The order of the AOI sequence is the order in which the AOIs were created.

**Previous**

Selecting this menu item (or the corresponding button on the button bar, see figure 1), will select the previous AOI in the sequence of AOIs displayed.

**Set Position**

Allows the user to manually position and size the currently selected AOI by entering coordinates of the upper-left (x1, y1) and lower-right (x2, y2) corners of the AOI. The coordinates can be saved and/or loaded from a file using the appropriate buttons. When the OK button is clicked, the AOI is redrawn at the new location. For Abel Transform Tool and Snake AOI, a slightly different dialog boxes are displayed.

![Set Aoi Position](image)

Figure 8. – Setting Aoi Position dialog box.

**AOI Options**

The options listed under this menu item are parameters for the particular AOI selected. Not all AOIs have options associated with them. If multiple AOIs have been created, then only the options for the one currently highlighted will be displayed. The different Options dialog boxes are shown below. Pressing “o” key is a shortcut for this menu item and will bring up one of the following options for which ever type of AOI is currently selected.
Angle Tool Options

![Angle Tool Options dialog box](image)

Figure 9. – Angle Tool Options dialog box.

**Angle relative to** – specifies the axis relative to which the angle will be displayed.

**Display mode** – specifies the angle display range.

**Angle** – displays the current angle.

**Rotate image clockwise by the angle** – performs rotation of the image by the angle displayed. This is useful for quick and easy rotation of the image along some axis. For example, an elongated object is oriented at some angle, say 170 degrees, and you want to stand it up vertically. Just position the Angle Tool such that it is aligned with the object (and displaying angle of 170) and select Aoi Options. Change “Angle relative to:” to “y-axis”, then select (checkmark) this option, and click OK button.
Threshold Tracking Options

Figure 10. – Threshold Tracking Options dialog box.

**Direction** – selects the tracking direction; i.e., this angle determines the direction in which AOI is searched. For example, if the direction selected is “Right”, or angle of 90 degrees, the AOI is searched from right to left for the first occurrence of a non-black pixel.

**Velocity Vector** – sets the distance (in pixels) by which the AOI jumps ahead before starting to search for track point. The velocity vector is used for predicting where the object should be in the next frame to increase the chances of a successful search.

**Constrain AOI to line** – constrains the AOI repositioning during tracking to a line. This may be useful in forcing an AOI to follow a predetermined path without being sidetracked. When this option is selected (and after OK in the dialog is clicked), a dashed line appears across the image, which can be rotated by dragging the arrow tip of the AOI angle selection arrow. There are two options, which determine where is the AOI allowed to look for track point. If “constrain search to line” is selected, the search only looks along the constraint line. If “allow full AOI search” is selected, the search will include areas away from the constraint line, but still inside the AOI bounds. If a track point is found off the line then the AOI will move to the point along to the constraint line that is closest to the track point.
Center Tracking Options

Figure 11. – Center Tracking Options dialog box.

**Method** – selects a method of locating the center point of an object. The “Center of Mass” method calculates the center point based on pixel’s intensity and its location. The Four Side Edge method uses the Threshold Tracking method to find a track point from four sides (left, right, top, and bottom) around an object. The left and right track point locations are averaged to obtain the x position of the center and the top and bottom track points are averaged to obtain the y position of the center.

Note that the Four Side Edge method *requires* a binary (thresholded) image for proper operation. The Center of Mass method works best with binary images but will work with grayscale images as well (care should be exercised with grayscale images because the background will contribute to the Center of Mass calculation and may throw off the center positions). When one of the threshold-based methods is selected, a threshold operation is automatically inserted into the Image Processing Sequence dialog box (see below). When the “center of mass – grayscale” is selected, the threshold operation is automatically removed from the IP Sequence dialog.

**Save data to Results file** – this selection controls how much information is reported to the results file and is meaningful only when the Four Side Edge method is selected. By default, only the x and y coordinates are reported to the Results file (two columns of numbers), but greater detail is available.

**Velocity Vector** – sets the distance (in pixels) by which the AOI jumps ahead before starting to search for track point. The velocity vector is used for predicting where the object should be in the next frame to increase the chances of a successful search.
Local Minimum Options

**Direction** – selects the angle of the constraint line, when the “Constrain to line” option is selected. The “Constrain to line” option constrains the AOI repositioning during tracking to a line. This may be useful in forcing an AOI to follow a predetermined path without being sidetracked. When this option is selected (and after OK in the dialog is clicked), a dashed line appears across the image, which can be rotated by dragging the arrow tip of the AOI angle selection arrow.

**Velocity Vector** – sets the distance (in pixels) by which the AOI jumps ahead before starting to search for track point. The velocity vector is used for predicting where the object should be in the next frame to increase the chances of a successful search.

Snake Aoi Options

**Energy function weights**
- Intensity
- Gradient
- Second derivative
- Even spacing
- Total length

**Velocity vector**
- X velocity
- Y velocity

**Ideal intensity**

**Pixels to search**

**Processing Radius**

**Snake points**
- fixed number
- variable (%)

**Result format**
- short - centroid/radius
- long - points under line

Figure 12. – Local Maximum Options dialog box.

Figure 13. – Snake Options dialog box.
Energy function weights – these parameters control how the snake moves. The energy function is the weighted sum of the terms and as such, their values are only important relative to one another. They are normalized such that their default contributions are approximately one.

**Intensity** – sets the weight given to the "Ideal intensity" (specified elsewhere in the dialog). It evaluates the difference between the "Ideal intensity" and the intensity of the image pixels under the snake, and tends to make the snake seek out parts of the image close to the ideal intensity, and avoid parts of the image that are farther from the ideal intensity.

**Gradient** – evaluates a gradient along a short line (7 pixels) perpendicular to each point of the snake. The energy decreases when gradient is large. A larger weight for this term causes the snake to seek out edges. Setting this weight to zero avoids the lengthy calculations involved in computing the gradients and greatly speeds up snake calculations (useful if you don’t care about edges).

**Second derivative** – increases the energy when the snake has sharp bends. A large weight here tends to make a closed snake want to be circular and tends to make a non-closed snake want to be a straight line. This term depends only on the shape of the snake and has nothing to do with the pixels in the image. Unfortunately, there are other interactions that affect this term (like the total size of the snake -which has effects on many of the terms), so it is hard to predict exactly what effect this term will have. It may be useful to help keep the snake from forming small loops that have little to do with image.

**Even spacing** – controls how important the snake thinks it is to have a constant distance between the snake's control points. A larger value here keeps the points from getting all bunched together. This term depends only on the shape of the snake and has nothing to do with the pixels in the image.

**Total length** – this weight is designed to offset the tendency of many of the other terms to shrink the snake down to nothing. It may be useful to put a small value here if the snake is shrinking too much (or possibly to get the snake to expand to fill a cavity). This term depends only on the shape of the snake and has nothing to do with the pixels in the image.

**Snake Points** – the snake points specify how many of the pixel points under the snake line are used in calculations of the energy function. If the “fixed number” is selected, the algorithm will use this number of points, evenly distributed along the length of the snake, no matter how long or short the snake is. If the “variable (%)” is selected, the algorithm will use that percentage of all points under the snake line. Thus, the longer the line the more points are used in calculations; a selection of 100% will use every pixel under the snake line, however the calculation will be very slow. The Snake Points selection also determines how many points are saved in the results file, see the Results Format paragraph below.

**Results Format** – this selection determines how the tracking results are written to the results file. If the “short” format is selected, then the output data fits on one line per each image. The results that are saved to a file are centroid, width and height, and average radius of the object. If the “long” format is selected, then the output data is written out in a multi-line format, i.e. columns of numbers per image. The results that are saved to a file are centroid, xy coordinates of points under the snake line, and the pixel (RGB) values at the xy coordinates. The exact number of data points saved to a file (in the long format) depends on the selection in the “Snake Points” section (see above). If a “fixed number” of points was selected, then that same number data points is output to a file.
**Velocity Vector** – sets the distance (in pixels) by which the Aoi jumps ahead before starting to search for track point. The velocity vector is used for predicting where the object should be in the next frame to increase the chances of a successful search.

**Ideal Intensity** – sets the pixel intensity level that the snake searches for and works in conjunction with the Intensity weight.

**Pixels to Search** – this parameter controls the optimization process used to find where the snake should move. Basically, the optimization process moves each control point, one at a time, evaluates the energy at the new points, and leaves that control point where the energy is lower. This value selects the number of pixels to initially move the control point. The default is set to 3, so the energy is evaluated with the control point moved to the eight combinations possible by moving it 3 pixels (up, down, right, left, and the four diagonal positions). If any of those positions are better than the current position, the control point is moved to the better spot and the process continues with the next control point. If all the positions are worse, the process is repeated moving only 2 pixels. If that fails, it tries again moving only one pixel. If that fails, it leaves the control point where it was and goes on to the next control point. If all the control points fail to move, then this is the best spot in the local area.

**Processing Radius** – sets the size of the image processing box around the snake. The processing box is a rectangular area outside of the snake in which the image processing algorithms are performed (before the snake algorithm is applied). A value of, say 20, means that the image processing box will be 20 pixels on-the-side bigger than the snake’s bounding box. The value doesn’t matter if no image processing is used.

**Slither button** – the slither button is a shortcut for testing the various parameters on the snake. For example, if the user wants to test the effect of changing the Intensity weight on the snake movement, the fastest way to do that is to make the change and press the Slither button. The snake will move based on the new set of parameters.

**Reset button** – this button can be pressed after a slither test to move the snake back to its previous position.
**Process Sequence**

Brings up the Image Processing Sequence dialog box through which a series of image processing operations can be performed inside the selected AOI. The image processing operations are selected and manipulated using the buttons at the right side of the dialog box and are displayed in the list box at the left side of the dialog box. Each of the image processing operations will be executed in the order shown in the dialog box.

![Image Processing Sequence dialog box](image.png)

Figure 14. – Image Processing Sequence dialog box.

**Add** – adds a new image processing operation to current list. Clicking the Add button brings up the Add IP operation dialog box (figure 15) through which the image processing operation is selected.

The **Add IP operation dialog box** – this dialog box is displayed when the Add button is selected in the Image Processing Sequence dialog box. Selecting one of these processing operations brings up the pertinent image processing options dialog box described in the Process section below.
Figure 15. – Add IP operation dialog box.

**Delete** – deletes the currently highlighted image processing operation from the list.

**Edit** – allows the parameters of the selected operation to be changed.

**Move Up** – changes the order of operations in the list. Clicking this button causes the currently highlighted operation to move up one step.

**Move Down** – changes the order of operations in the list. Clicking this button causes the currently highlighted operation to move down one step.

**Load** – loads a previously saved sequence of image processing operations from a file. Clicking this button brings up a “Load” dialog box through which the selection is made.

**Save** – saves the current sequence of image processing operations to a file. Clicking this button brings up a “Save As” dialog box through which the file selection is made.

**Update**

Executes the operations selected in the Process Sequence dialog box and performs the selected tracking operation on the AOI currently selected. This lets the user preview the effect of the selections and acts as a check on whether the options and image processing do what is expected. Thus, if the current AOI is ThresholdTrackingAoi then this menu item executes the threshold tracking function. If the snake is currently selected then this menu item executes the slither function. Pressing “u” key is a shortcut for this menu item.
Process

The menu items under the Process menu perform either image processing operations or image statistics calculations. All of the operations operate on an AOI and are designed to perform analysis on a single image frame. The idea behind the Process menu is to interactively perform image processing analysis and testing on one or more typical image frames to determine what processing should be done during tracking. Selecting one of the Process menu items will normally bring up a dialog box offering further options.

Threshold

Performs a threshold operation. In a simple threshold operation, the pixels are set either to 0 or 255 depending on the threshold value. Spotlight provides two other types of threshold operations in which some pixels will be left unaffected (with original values) while others will be set to 0 or 255. Selecting this menu item brings up the Threshold selection dialog box, described below. This image processing operation is an interactive operation, in which the user sees the processing performed immediately by dragging the slider.

![Threshold dialog box](image)

Figure 16. – Threshold dialog box.

**Type** – selects the threshold method to be performed. In a Simple threshold operation, all pixels are set either to 0 or 255 depending on the threshold value and the threshold mode. In a Low Pass type of threshold, all pixels with a grayscale value below the threshold level will be left unaffected, while pixels above the threshold level will be set to 0. In a High Pass type of threshold, all pixels with grayscale value above the threshold level will be left unaffected while pixels below the threshold level will be set to 0.

**Mode** – this selection determines if pixels are set to 0 (black) or 255 (white). When mode is set to Standard then pixels below threshold level are set to 0. When mode is set to Inverse then pixels below threshold level are set to 255.

**Level** – the transition value (also know as threshold level).

**% of pixels above threshold** – gives a measure of how many pixels are affected by the threshold.
Filter

Performs a filtering operation using a convolution kernel. Selecting this menu item brings up the Filter dialog box, described below.

![Filter dialog box]

Figure 17. – Filter dialog box.

**Smooth** – a convolution weighted averaging filter employing a 3x3 kernel. In this filter each pixel is replaced by a weighted sum of its neighbors. The central pixels are weighted more than the outer pixels. This type of filter is effective in reducing a Gaussian random noise such as the type generated by a digitizer or a tapedeck.

**Smooth More** – similar to a Smooth filter, but uses a 5x5 kernel.

**Blur** – severe smoothing filter.

**Contour** – a type of edge detection filter.

**Sharpen** – a low strength sharpening filter using a 3x3 kernel.

**Sharpen more** – a medium strength sharpening filter.

**Edge Enhance** – high performance sharpening (high-pass) filter.

**Edge Detect** – basic edge detection filter.

**Invert** – produces an effect known as inverse video. The grayscales are flipped about the 50% intensity (middle of the intensity range).
Arithmetic

Performs an arithmetic operation between two images or between an image and a constant. If the operation is between the current image and a constant, every pixel of the image is evaluated relative to the constant. If the operation is between the current image and a second image (obtained from a disk file), every pixel of the current image is evaluated relative to the corresponding pixel in the second image. Both images must be the same size. Selecting this menu item brings up the Arithmetic dialog box, described below.

![Arithmetic dialog box](image)

**Source 1** – selects one of the two inputs to the operation. There are three possible inputs to source 1. “This AOI” selects the image currently contained within the AOI. “Constant” selects the input to source 1 to be a constant, which is typed in the box on the right. “File” selects a file from disk.

**Source 2** – selects one of the two inputs to the operation. There are three possible inputs to source 2. “This AOI” selects the image currently contained within the AOI. “Constant” selects the input to source 2 to be a constant, which is typed in the box on the right. “File” selects a file from disk.

**Operation** – these options select which Arithmetic operation to perform between source 1 and/or source 2. The operation is performed between every pixel of the image. The resulting pixel values are limited to a range of 0 to 255.

- **Add** – adds source 2 to source 1 or a constant to source 1.
- **Subtract** – subtracts source 2 from source 1 or subtracts a constant from source 1.
- **Multiply** – multiplies source 1 by source 2. However a more common usage is to multiply source 1 by a constant (floating point value) to improve contrast.
- **Divide** – divide source 1 by a constant.
- **Difference** – subtracts source 2 from source 1 then takes an absolute value of the difference.
**Lighter** – compares the two images, pixel by pixel, and returns a new image containing the lighter value for each pixel.

**Darker** – compares the two images, pixel by pixel, and returns a new image containing the darker value for each pixel.

**Blend** – compares the two images, pixel by pixel, and returns a new image containing the blend of the two pixels.

**Contrast**

Performs a contrast stretching operation. Contrast stretching alters the pixel values by changing the distribution of the intensity histogram. Selection of this menu item brings up a Contrast Stretching dialog box, described below.

![Contrast Stretching Selection](image)

Figure 19. – Contrast dialog box.

**Type** – the type of contrast stretching operation.

- **Linear Contrast Stretch** – linearly re-maps the current range of intensities in the AOI to a full intensity range.

- **Histogram Equalization** – performs the classic histogram equalization by re-mapping the pixel intensities such that the resulting image histogram is roughly linear.

- **Adaptive Contrast Stretch** – re-maps the pixel intensities adaptively by performing a linear contrast stretch on small adjacent areas (specified by SubAoi Size option) and then smoothly merging the SubAoi’s intensities. The algorithm is known as the Pizer method.
Morphological

Performs binary (threshold-based) morphological operations. It is assumed that a threshold operation has been performed before one of the morphological filters is used, which converts the image to pure black and pure white. The background is assumed to be black and foreground is white.

Figure 20. – Morphological filter dialog box.

**Erode** – in this operation, any pixel whose neighborhood is not completely white, is changed to black. This operation has the effect of changing white edge pixels to black, thereby decreasing the size of an object. If two or more objects are connected, erosion has the effect of separating the objects.

**Dilate** – in this operation, any black pixel that has at least one white neighbor is changed to white. This operation has the effect of changing black edge pixels to white, thereby increasing the size of an object. If two or more objects are separated by a gap, dilation has the effect of fusing the objects together.

**Reconstruct** – attempts to “reconstruct” an object from a set of markers. These markers are the results or leftovers of an eroded image. This algorithm works in several steps. First, several iterations of erosion are applied to the image until the small, unwanted objects (crud) are eroded away. What is left of the erosion is called a marker image and the objects in the marker image are called markers. Then the original image is then superimposed over the marker image. And finally, all objects touching any of the markers are kept, and all others are eliminated. See Example 2 on how to use this function.

**Outline** – generates an outline of an object. All interior pixels of an object are set to black, and only the edge pixels are left untouched, thereby creating an outline.

**Skeleton** – performs a thinning operation until a skeleton of the object is obtained. A skeleton is a result of repeated thinning operations until the object is reduced to single pixel thick lines. NOTE: this operation is currently not implemented, but will be in the near future.
**Hole Fill** – fills in any holes in an enclosed grouping of pixels (object).

**Hole Extract** – performs an “inverse” of Hole Fill; holes are extracted from the image while all other pixels are set to black. Essentially it swaps the pixel value between a hole and the object. Thus, pixels what were white (object) are changed to black and pixels that were labeled as part of a hole (black) are changed to white.

**Border Kill** – eliminates (changes to black) all pixels that are connected to pixels touching the border of an AOI. Any object separated by a gap from an AOI border will be left untouched.

**Border Line Kill** – sets all image border pixels to black (1 pixel thick line around the image).

### Extract Plane

Extracts a plane (channel) from a color (RGB) image. It should be noted that extracted plane (which is grayscale) is then converted to color so that it can be reinserted back into the original image for viewing. Selecting this menu item brings up the Extract Color Plane dialog box, described below.

![Extract Plane Selection](image)

Figure 21. – Extract Color Plane dialog box.

**Red** – extracts a red plane (channel) from a color image.

**Green** – extracts a green plane (channel) from a color image.

**Blue** – extracts a blue plane (channel) from a color image.

**Luminance** – extracts the luminance plane from a color image. This is done by converting the color image to grayscale and then extracting one of the channels.
Geometric

Performs either rotation or translation of the image in the AOI. Selecting this menu item brings up the Geometric Functions dialog box, described below.

Figure 22a. Geometric Options dialog box, Rotate.

**Rotation** – rotates the area inside the current AOI by the angle specified.

Figure 22b. Geometric Options dialog box, Roll.

**Roll** – rolls (translates) the area inside the current AOI by the translation distance in the direction specified.
Statistics

Returns image statistics data. Selection of this menu item brings up the Image Statistics dialog box, shown below. The options available depend on which type of AOI is currently selected. For example the Line Profile option is enabled only for a line or line profile type AOI.

NOTE: This operation automatically outputs data. If one of the statistics operations is selected in the Process Sequence dialog box, the output is stored in the “results” file. However if this operation is executed from the Process->Statistics menu then the data is displayed to the screen in a dialog box.

![Image Statistics dialog box](image)

Figure 23. – Image Statistics dialog box.

**Min, max, mean, stdev** – calculates the statistics and returns as four numbers. This option is available only for rectangular AOIs.

**Histogram (rectangle aoi)** – calculates a histogram of pixel intensities in the AOI. Currently the output data (the histogram) can be saved to a file only by executing this function through the Process Sequence dialog box.

**Line profile (line aoi)** – saves the pixel intensities under the line AOI. Currently the output data (the line profile) can be saved to a file only by executing this function through the Process Sequence dialog box.

**Area** – calculates the number of the pure white pixels in the image. This measurement requires that the image be thresholded before area calculation is performed.
Save Aoi

Saves the sub-image surrounded by the AOI to a file on disk. This operation is particularly useful when saving AOI(s) from a sequence of images. Selecting this menu item brings up the Save Aoi dialog box, described below.

![Save Aoi dialog box]

- **Base file name** – a name of a file (and path) to which the AOI is saved. The term “Base name” refers to the part of the filename without the appended numbers and the file extension. The numbers are appended if the “Append number” option is checked. The file extension is appended automatically. The name (and path) can be either typed in by hand or selected with the “Select” button. An extension (“.tif”, etc.) will be added automatically by the routine.

- **Append number** – enables numbering to be appended sequentially to the base file name, starting with the number typed here. This number will be incremented automatically each time a new frame is loaded.

- **Save as grayscale** – specifies that the AOI be saved as a (grayscale) image if the current image is color. This option is ignored if the original image is grayscale.

Extract Field

Extracts a field image from a frame image.

![Extract field dialog box]

Figure 25. – Extract field dialog box.
**Extract** – this option selects which field to extract. The “Odd” field is the first field (in terms of time) in the image and is comprised of rows 0, 2, 4…, while the “Even” field is the second field (temporally) and is comprised of rows 1, 3, 5… The in-between rows are filled in by interpolating the existing field rows using bilinear interpolation. The last option will swap the order of the two fields. This may be necessary to correct for improperly created AVI files.

**Pseudocolor**

This menu item brings up a “Load Palette” dialog box through which a color palette file (also known as a lookup table or LUT) can be selected and loaded. When the palette is loaded (and applied to the image) the effect is that the current image gets pseudo-colored. Exactly how the image gets pseudo-colored depends on the state of “Apply palette to display” option in the Program Options dialog box. See the Users Guide for a more detailed discussion on Color Palette Application. *Note: this operation operates on the whole image, thus the Whole Image AOI must be selected.*

**Resize Image**

This menu item brings up a dialog box for specifying new width and height. *Note: this operation operates on the whole image, thus the Whole Image AOI must be selected.*

![Resize Image dialog box](image)

Figure 26. – Resize Image dialog box.

**Pixel Dimensions** – shows the “new” width and height fields which are the desirable dimension. The original width and height fields are not editable.

**Tracking**

The menu items under the Tracking menu deal with performing tracking and managing how data is stored in an output file. See also the “Tracking” section in the Users Guide.

**Track 1 Frame**

Selecting this menu item or clicking the corresponding button on the button bar causes Spotlight to track one frame and then stop. This function is useful to check if everything is proceeding as expected. Once everything is working well, then continuous tracking may be employed.
Track Continuously

Selecting this menu item or clicking the corresponding button on the button bar causes Spotlight to start the continuous tracking process. This menu item works like a toggle, thus a second execution of this menu item (or clicking the button again) causes tracking to stop.

Result File

Brings up a Results File dialog box used for selecting a file to store the tracking results. If an output data file is not explicitly selected, Spotlight will write the tracking data to a default file named “results.txt”. The data is written to the file after every frame. The data is written in a column format.

![Select file for tracking results dialog box](image)

Figure 27. – Tracking results selection dialog box.

**Filename** – name and path of the result (output data) file. It can be typed by hand or it can be selected with the “Select” button.

**Select** – brings up a Save As dialog box through which the result file name and path can be selected. The path and file name selection is displayed in the “File name” box above.

**Empty this file now** – deletes the contents of the currently selected result file. The user is prompted one more time before the action is executed.

**View** – displays the contents of the result file. Note: in order for the data to line up in columns, the font of Windows Notepad must be set to a fixed-width font, like Courier.

Help

These menu items contain information about Spotlight.

View Documentation

Displays the Spotlight documentation file (this document) in the local PDF viewer.

New Since Last Release

Displays a dialog box showing a history of what is new since the last release. This includes a list of bug fixes, additions, and improvements.

About Spotlight

Displays information about the current release version, date, authors, and a list of libraries used by Spotlight.
Appendix 1

Examples

Example 1. Easy tracking example using Threshold Tracking AOI

This is a brief example of a simple tracking session to introduce some of the Spotlight concepts.

Figure 28. – Simple tracking example.

1. Start the program.

2. In this example, we will be tracking from the sample images installed with Spotlight. To open the first of these images, select “File->Open” from the Spotlight menu, go to the directory where Spotlight is installed (by default, in ‘/usr/local/lib/Spotlight’ on Linux, and in C:\Program Files\SpotlightX.X on Windows), double-click the “DemoImages” folder to look in that directory, then double-click the “im001.jpg” file to load that file into Spotlight.

3. Notice that some of the buttons toward the right side of Spotlight have become active. These buttons (and the corresponding items on the “Transport” menu - all buttons have corresponding menu items) are similar to the buttons on a tape deck. There are buttons for advancing frames, “playing” a sequence of frames, “rewinding” to the start of the sequence, etc. Try some of these buttons, and watch how they affect the sequence of images. Also notice the file name of the currently displayed image in the title bar of the Spotlight window. Rewind back to the first image when you are finished experimenting.

4. Spotlight does not normally examine all of an image; it usually works with an only a small portion called
the “area of interest” or AOI. Create a new Threshold Tracking AOI by clicking on the “Aoi->New->Threshold Tracking” menu item. Notice the rectangle with the small arrow inside it that appears in the image. This is a Threshold Tracking AOI. Spotlight will only look at image pixels that are inside of this rectangle. Clicking on the corner of the AOI and dragging the mouse will change the size of the AOI, and clicking and dragging on the end of the arrow will change the tracking direction. These points are called the “control points” of the AOI. You don’t want to do those things yet, so click and drag the mouse somewhere not near the control points to move the whole AOI. This example will track the right edge of the ball in the image. Drag the Threshold Tracking AOI so that it is centered roughly on the right edge of the ball.

5. Click on the “Track Continuous” button (the button farthest to the right). Watch as the sequence of images is loaded and the Threshold Tracking AOI centers itself on the right edge of the ball.

6. Take a look at the results that Spotlight saved to a file. Click on the “Track->Results File...” menu item. A dialog box that lets you select the file in which to store the results will pop up. You can see that Spotlight has already put the results in the default file named “results.txt”. Click on the “View” button to load that file so you can see what Spotlight found. You will see a table that shows the X and Y position of the right edge of the ball (measured in pixels) versus time (measured in frames).

That’s all there is to basic tracking. Things were slightly simplified here because there was not much needed in the way of image processing and the default tracking parameters were acceptable. Here is a more complicated example that continues from where the previous example leaves off:

1. Close the result file, cancel the “Results File” dialog box, rewind back to the first image, and drag the Threshold Tracking AOI back to center on the right edge of the ball.

2. Imagine that instead of a nice, clearly defined ball (designed to be easy to track), you are working with a poorly defined particle that needs some image processing to find the edge. Click on the “Process->Filter...” menu item. A dialog box with different types of filtering algorithms will pop up. Select “edge detect” filter and click on OK. Notice that the image is processed with this algorithm inside of the AOI immediately. There is now a nice, sharply defined line in the AOI that shows the position of the edge.

3. Imagine that Spotlight needs to apply that image processing operation for each frame in order to correctly find the edge. Instead of applying the operations immediately as we have been doing, we need to tell Spotlight to do them automatically when it tracks (in a batch mode). This is done with the “Aoi->Process Sequence...” menu item. Notice that the dialog that pops up already has a “Threshold – simple – standard (128)” operation in the sequence. Threshold Tracking will always have a threshold operation as the last item in the sequence list. We want to add our image processing operation to the sequence. This is done by clicking on “Add”, “Filtering”.

4. The operation’s subtype and other parameters default to the last parameters you selected, so the correct values are already inserted into the sequence list. But, you could click on “Edit” at this point to change the operation subtype or other parameters. As an example, click on the “Threshold – simple – standard (128)” item in the sequence list to highlight it, then click on “Edit”. A dialog box will pop up showing the parameters of the threshold operation. The parameters are set to do a “simple” threshold that sets all of the pixels with an intensity below 128 to black (level 0) and all of the pixels above 128 to white (level 255). Click on OK twice to close the dialog boxes. That sequence of 2 image processing operations will be performed each time the AOI is updated while tracking.

5. Next, create a second AOI to track the left edge of the ball. Clicking on the “Aoi->New->Threshold Tracking” menu item again does this. A second Threshold Tracking AOI will appear next to the original AOI. Notice that the new AOI is bolder, and the first AOI is slightly dimmer. This is to let you know that any settings you change now will affect the second AOI and not the first. Also notice the two buttons with the arrows and green boxes have become active. These are the “Next AOI” and “Previous AOI” buttons that let you select the AOI you want to work with. Try them out and watch what happens to the AOIs.
6. Make sure the new second AOI is highlighted, and drag it over to the left edge of the ball. The arrow on the AOI still points to the right, but we want it to point left to track the left edge. Dragging the head of the arrow over to the left can change it, but it is more precise to do this from a dialog box. Click on “Aoi->Aoi Options” to bring up the Threshold Tracking Options dialog box. Click on “Left”, then “OK” to set the AOI to track the left edge.

7. Click on the “Aoi->Process Sequence...” menu item. Notice that the image processing operation that we added to the first AOI is also there for the second AOI. This is because when you create a new AOI which is the same type as the one highlighted, the first AOI is duplicated as much as possible. Click “OK” to close the dialog.

8. Click the “Track Continuously” button to begin tracking, and look at the results just as you did before. Now there are position results from both AOIs verses time.

**Example 2. Center tracking using morphological functions**

This example shows how to track center point and how to use morphological function to remove unwanted objects.

![](image.png)

Figure 29. – Center Tracking example.

1. In this example, we will be tracking from the sample image sequence installed with Spotlight. To open the first of these images, select “File->Open” from the Spotlight menu, go to the directory where Spotlight is installed (by default, in `/usr/local/lib/Spotlight` on Linux, and in `C:\Program Files\SpotlightX.X` on Windows), double-click the “DemoImages” folder to look in that directory, then double-click the “imSoot1.jpg” file to load that file into Spotlight. Note: if any AOI’s are still open from the previous example, delete them by clicking on “Aoi->Delete”.

---

**NASA/TM—2006-214084**

43
2. We want to track the center of the fuel droplet, which is the dark circle surrounded by quite a bit of soot particles. Therefore we will use the Center Tracking AOI by clicking on “Aoi->New->Center Tracking” menu item. A square box with a small center cross appears near the upper-left corner of the image.

3. Move the center AOI box to the center of the droplet (center coordinates of (145, 155)), and resize it so that it measures approximately 120 pixels on a side. (One easy trick to setting the AOI size is to move it to the upper-left corner of the image and then drag the lower-right corner of the AOI while watching the status line until desired size is reached. The final coordinates should show something like: (0, 0) (120, 120). Then you can move the AOI to the desired location.)

4. First, we need to determine what threshold levels to use. Select “Process->Threshold” menu item to bring up the Threshold dialog box. Under “Mode”, select “Inverse” to inverse the pixel gray-levels to the Spotlight convention of black background and white foreground. Drag the slider and watch what happens inside the AOI. Level of about 0.156 seems to preserve the right size of the droplet. (Note: the image in Figure 29 was taken at this point) Click OK button to close the Threshold dialog box. What you should be seeing inside the AOI is black background and one large white circle surrounded by white soot particles.

5. We need to get rid of the soot particles. One way of doing that is to use the morphological reconstruct algorithm (see the Morphological Operations in Reference Guide for explanation of Reconstruct algorithm). Click on “Process->Morphological” menu item to display the Morphological dialog box. Select “Erode” and make sure that “iterations” is set to 1. Click the OK button. Much of the soot particles have been eroded away but some still remain. Click the “Redo” button on the button bar to execute another iteration. Now all the soot particles have been eroded away and only the droplet (white ball) is left. Now we know that a minimum of two iterations are needed to wash away all the extra crud. Click “Redo” couple more times. That’s a total of 4 iterations of erosion. The droplet is still there, just smaller. Now click “Undo” button 4 times to get back to the original thresholded image. Bring up the Morphological dialog box again and select Reconstruct algorithm and set the iterations to a number 4. Click OK. All crud disappears but the droplet is left untouched.

6. To make Spotlight apply the procedure we just tested to every frame, we need to input these operations into the Process Sequence dialog box. Click “Aoi->Process Sequence…” menu item to bring up a dialog box. Threshold operation is already selected because it is always needed for Center Tracking (it is a mandatory last operation). We must put our image processing operations before this mandatory threshold operation. Click Add button and then click Threshold button. Note that Threshold operation was added to the list. Click Edit button and make sure that “Inverse” is selected and the level is 0.156. Click OK to close. Click Add button again and then click Morphological button. Click Edit button and make sure that Reconstruct is selected and number of iterations is 4. Click OK. Click OK again to close the Image Processing Sequence dialog box.

7. Test the sequence to make sure everything is set up correctly. Click “Step forward” button followed by clicking the “Step back” button to load a fresh image. Click on the “Aoi->Update” menu item. This executes sequentially all operations that are selected in the Image Processing Sequence dialog box.

8. Click on the “Track Continuous” button to begin automated tracking. To view the output file, click on “Track->Results File…” and then click on the “View” button.

**Example 3. Tracking an outline with a Snake Tracking AOI**

The Snake Tracking AOI is a fairly complicated type of an AOI and it is encouraged for the user to read the Reference Guide sections related to Snake Tracking. The first section is under the description of menu item
Aoi, New, Snake tracking, and second section is under the menu item Aoi, Aoi Options, Snake Aoi Options. It also helps to have a very fast processor, as this algorithm is computationally intensive.

1. In this example, we will be tracking from the sample image sequence installed with Spotlight. To open the first of these images, select “File->Open” from the Spotlight menu, go to the directory where Spotlight is installed (by default, in `~/usr/local/lib/Spotlight` on Linux, and in C:\Program Files\SpotlightX.X on Windows), double-click the “DemoImages” folder to look in that directory, then double-click the “sphere1.jpg” file to load that file into Spotlight. Note: if any AOI’s are still open from the previous example, delete them by clicking on “Aoi->Delete”.

2. We want to track the outline of the spherical flame ball (in microgravity flame forms a sphere around the source). For that we’ll use Snake tracking by clicking “Aoi->New->Snake Tracking”. At this point Spotlight is waiting for you to specify where to draw the snake.

3. The snake drawing is done by clicking the right mouse button. Each time you right-click, a new control point appears on the screen. Start by right-clicking about 1 cm. directly above the flame sphere, a little cross appears at the cursor. Repeat adding a control point by right-clicking at approximately 2 o’clock, 4 o’clock, 6 o’clock, and 8 o’clock positions 1 cm. outside the sphere. At the 10 o’clock position, double-click the right button, which will close the snake. Make sure the snake line lies completely outside of the flame sphere; if at some point the snake line crosses the sphere edge, drag a nearby control point outward with the left mouse button. Note the flexible stretching of the snake line.

4. Now we need to select the proper energy function weights to make the snake move the way we want. To do that, click on “Aoi->Aoi Options…” menu item to bring up the Snake Options dialog box (a shortcut to display any Options dialog box is to simply press the key “o” on the keyboard) and move the dialog box to the side so you can see the snake.

Figure 30. – Snake tracking example.
5. Click the “Slither” button and watch the snake move. Looking closely where the line constricted onto the flame sphere, we see that the default setting did a pretty good job but we may not want the snake to hug the sphere so tightly. Click “Reset” button to move the snake back. Then set the “Ideal Intensity” to 0.27 (or 68 on 0-255 scale), which more closely approximates the intensity level (grayscale) of the edge of the flame sphere. Click “Slither” button again. In this way the “Slither” and “Reset” buttons can be used to interactively find the best set of energy weights.

6. Since we want the outline of the flame, e.g. the x,y coordinates of pixels under the line, select “long – points under line” option under “Results format”. Also, notice that “fixed number” option is selected under the “Snake points” group box. This means that no matter how long or short the snake line stretches, the same number of evenly spaced points, 50 by default, will be saved into the results file.

7. Click the “OK” button to close the Options dialog box and click on the “Track Continuous” button on the Spotlight button bar to begin automated tracking. To view the output file, click on “Track Results File…” and then click on the “View” button.

Example 4. Record coordinates of a line using Line Following AOI

The Line Following AOI is useful for saving (xy) coordinates of a line to a file. First, the image object must be reduced to a thin line, then the line following algorithm walks along the line, saving each pixel coordinate as it goes. The line following algorithm uses the direction (angle) of the previous three points found to preferentially look for the next pixel on the line. This tends to skip most burrs and jagged corners yielding a smoother line. The Snake AOI can also save the line coordinates (among other things) but the Line Following AOI tends to work faster and be better at following sharp corners, so they tend to be used for different applications.

Figure 31. – Line Following example.
1. To simplify the procedure, let’s start with a clean version of Spotlight; if the program is currently running, please close it and restart it again. This will ensure default values.

2. In this example, we will be tracking from the sample image sequence installed with Spotlight. To open the first of these images, select “File->Open” from the Spotlight menu, go to the directory where Spotlight is installed (by default, in ‘/usr/local/lib/Spotlight’ on Linux, and in ‘C:\Program Files\SpotlightX.X’ on Windows), double-click the “DemoImages” folder to look in that directory, then double-click the “fluid0.jpg” file to load that file into Spotlight.

3. The goal here is to save the coordinates of the edge of the fluid interface for each frame and build up a family of curves. Select the Line Following AOI from the menu by clicking on “Aoi->New->line following”. A square box appears near the upper-left corner of the image.

4. Move the AOI box, while watching the coordinates on the status bar, so that the upper-left corner of the box is at a coordinate of about (43, 15) and then resize the box by dragging the lower-right corner to a coordinate of about (190, 270).

5. Some image processing must be done to reduce the edge of the fluid to a thin line (one pixel thick). As we’ve seen in previous examples, add the image processing operations to the Process Sequence dialog box to apply them to every frame. Click “Aoi,Process Sequence…” menu item to bring up the dialog box. Click Add button and then click Filtering button. Click Add button again and this time click the Threshold button. Click Add button again and this time click the Morphological button. Here we need to change the morphological filter to Outline. To do this, click the “Edit” button in the Process Sequence dialog box and then select “Outline” and then click OK. Now there should be three filters selected in the Process Sequence dialog box; smooth filter followed by threshold filter followed by morphological outline filter. Click OK to close the Process Sequence dialog box.

6. Click the “Track One” button to track one frame at a time. At this point the image inside the Line Following AOI should look just like the one shown in Figure 31. The Stop button is showing and the program is waiting for you to click on the line to give it a start point. Click anywhere on the line and watch the line turn red, indicating exactly which points were saved to the results file. The procedure may be repeated for each frame by clicking on the “Track One” button or the user may want to enter a semi-automated tracking mode by clicking on the “Track Continuous” button. Note that even in the continuous tracking mode the program waits for the user to click the line after each frame.

7. To view the output file, click on “Track,Results File…” and then click on the “View” button. The x and y coordinates of each line are saved as columns of numbers.
Appendix 2

Abel Transform

The Abel Transform Tool is used to recover the spatial distribution of a physical property from which the line-of-sight projection is generated during imaging. The generic Abel Transform can be expressed by the following equation:

\[ f(r) = -\frac{1}{\pi} \int_{r}^{\infty} \frac{p'(l)}{\sqrt{l^2 - r^2}} dl \]

where \( f(r) \) is the spatial distribution of the physical property, while \( p(l) \) is the input data for the Abel Transform which can be directly or indirectly obtained from experimental images depending on the nature of the diagnostic method used. In addition to generic Abel transform, a Filtered Abel Transform may be selected which incorporates data filtering operation in the Abel Transform. Various filtering schemes are provided. Users are referred to the reference paper for the detailed treatment of data filtering.

To facilitate data reduction of laser extinction for soot volume fraction measurement (SVF), the Tools include an option of SVF which performs calculations to generate \( p(l) \) from a background image and a laser extinction image with three user-input constants: soot refractive index, laser wave length and the spacing between two neighboring pixels.

The Abel Transform Tool consists of a horizontal line profile and a vertical centerline. It is assumed (expected) that the flame is oriented vertically such that the horizontal profile cuts across it. If an image must be rotated, the Angle Tool may be used for this purpose. Of course if a reference image is used, it must be rotated in exactly the same way as the flame image.

Usage

Selection of Abel AOI brings up the Abel Transform Tool and the corresponding dialog box. Position the tool’s vertical centerline in the center of the flame with the horizontal profile line positioned at the desired height along the flame. As the tool is moved, the line profile is displayed “live” in the dialog box. Make sure the Options are correctly selected. Click the SVF button or the Intensity button to calculate the distribution. The distribution is plotted (red) in the window along with flame profile (black) and reference profile (blue). The centerline (green) is there to help with visualization.

A brief mention about the treatment of the centerpoint. The profile length is forced to be an odd number. This way there is always a centerpoint with left and right sides the same length. Since the Filtered Abel transform assumes axisymmetric input distribution, only half the data is passed to the Abel Transform function. The profile is split into left and right halves and the order of the left array is reversed. The centerpoint is added as the first element of both arrays. Whether the left and right halves are averaged or processed separately (Options selection), the data that is fed to the Abel Transform function is only half the length of the original line profile (plus the centerpoint). The output distribution is then remapped in reverse order, thus doubling up to create left and right side and the two centerpoints merged into one. The resultant distribution has the same number of elements as the original line profile and is symmetric about the centerpoint (if the Averaging Option was selected).
SVF button – calculates Soot Volume Fraction of pixel data under the line.

Intensity button – calculates Intensity-based Abel transform of pixel data under the line. The resultant transform is the “flame property” f(r).

Line Thickness – changes the thickness of the profile line. The pixels under the thickened line are averaged perpendicular to the length of the line before being displayed.

Lock x-axis movement – when checked prevents horizontal movement of the Abel transform tool. This is designed to allow easy vertical movement along the centerline of the flame.

File menu

Load previously saved Abel graph

Loads a file that was previously saved with the Abel Transform Tool. The data in the file are displayed in the graph window.

Load demo – filter test

Loads a file containing ideal projection function, which was generated from a step function of 0.1 to 1.0. The output depends on the filtering option selected by the user. This demo is meant to show the effects of various filtering options on an ideal function. The distribution is calculated by clicking the Intensity button.

Save

Saves the contents of the graph window to a file.
Options menu

General Options...

Displays the General Abel Options dialog box.

Figure 33. – General Abel Options dialog box.

Abel Filters – selects the type of filter to use.

Smoothing Factor – smoothing factor to use with the filter.

Averaging Option – selects whether the line profiles of left and right side of the Abel Transform Tool are to be averaged together or taken separately. If averaging is selected then the left side of the line profile is averaged with the right side and the average is used in the Abel transform calculation. The resultant distribution then is doubled and one side flipped horizontally making it symmetric about center. This may reduce the noise some.
SVF Options...

Displays the Soot Volume Fraction Options dialog box.

![SVF Options dialog box](image)

Figure 34. – Soot Volume Fraction Options dialog box.

**Physical parameters** – parameters used in the SVF calculation.

- **Pixel separation (mm)** – physical separation between detector elements.
- **Wavelength (nm)** – wavelength of the laser beam.
- **Soot refractive index** – a constant determined by the optical properties of soot particles.

**Background Selection** – background selection determines the reference profile, needed in the SVF calculation.

- **Background (ends of Abel tool)** – uses estimated constants to generate a reference profile. These constant values (one for left and one for right) are calculated from an average of an 8x8 pixel area at ends of the horizontal profile line. It is assumed that the line is wider than the flame and thus the reading comes from the image background outside of the flame.
- **Reference image** – selects a reference image from which the reference profile is read. The reference profile is read from the exact coordinates that the flame profile is read. The path of the image file may be typed in or the Select button may be used to select the file directly. The reference image must have the same scale and rotation as the flame image in order to ensure pixel to pixel correspondence between the two images.

**References:**
Appendix 3

Software Used To Write Spotlight

Python 2.4.1 (programming language)
http://www.python.org

PIL 1.1.5 (Python Imaging Library – used for some 8-bit processing functions)

wxPython 2.6.1.0 (GUI toolkit)
http://wxpython.org/

wxDesigner 2.13c (dialog editor for wxWidgets/wxPython)
http://www.roebling.de/default.html

py2exe 0.5.4 (Windows installer – gathers the necessary files to a single location)
http://starship.python.net/crew/theller/py2exe/

Inno Setup (Windows GUI installer – a user-friendly install wizard)
http://www.jordanr.dhs.org/isinfo.htm

Software License

by Robert B. Klimek, Ted W. Wright
Permission to freely use, copy, and distribute this software [Spotlight] and its associated documentation is hereby granted.

wxPython
Copyright © 2005 by
Julian Smart, Robert Roebling, Vadim Zeitlin and other members of the wxWidgets team.

Python Imaging Library (PIL)
Copyright © 1997-2005 by Secret Labs AB
Copyright © 1995-2005 by Fredrik Lundh
Permission to use, copy, modify, and distribute this software [Python Imaging Library] and its associated documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appears in all copies, and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Secret Labs AB or the author not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
**Spotlight–8 Image Analysis Software**

Robert Klimek and Ted Wright

National Aeronautics and Space Administration  
John H. Glenn Research Center at Lewis Field  
Cleveland, Ohio  44135–3191

National Aeronautics and Space Administration  
Washington, DC  20546–0001

Responsible person, Robert Klimek, organization code PTL, 216–433–2837.

Available electronically at [http://gltrs.grc.nasa.gov](http://gltrs.grc.nasa.gov)  
This publication is available from the NASA Center for AeroSpace Information, 301–621–0390.

Spotlight is a cross-platform GUI-based software package designed to perform image analysis on sequences of images generated by combustion and fluid physics experiments run in a microgravity environment. Spotlight can perform analysis on a single image in an interactive mode or perform analysis on a sequence of images in an automated fashion. Image processing operations can be employed to enhance the image before various statistics and measurement operations are performed. An arbitrarily large number of objects can be analyzed simultaneously with independent areas of interest. Spotlight saves results in a text file that can be imported into other programs for graphing or further analysis. Spotlight can be run on Microsoft Windows, Linux, and Apple OS X platforms.

<table>
<thead>
<tr>
<th>Subject Terms</th>
<th>Image analysis; Image enhancement; Image processing; Change detection; Image correlation</th>
</tr>
</thead>
</table>

Unclassified - Unlimited  
Subject Category: 59

Available electronically at [http://gltrs.grc.nasa.gov](http://gltrs.grc.nasa.gov)  
This publication is available from the NASA Center for AeroSpace Information, 301–621–0390.